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what are google ads.
*this is meant as a study guide that was created from lecture videos and is used to help you
gain an understanding of what are google ads.
Google Ads Foundations
Capitalize every letter in headline

Include keywords in ad text

Tie the call to action in ad to match the landing page

Google Search

-Gain advantage over organic

-Reach customers actively searching for your product

Google Display (Banner Ads) Network

-wide range of customers with broad interests

-brand awareness and customer loyalty

-increase engagement with customers

-speciﬁc placement targeting
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*Ads Editor to quickly manage GoogleAd on Desktop

Google Ads Structure

Account- Email, Password, Billing Info

Campaign- broad objective, budget, setting when ad appears

Ad Groups- set of similar ads and keywords that trigger select advertisements

Best Practices

Organize your campaign and ad groups from the start

Start with speciﬁc ads and targeting, then loosen up if not getting enough traﬃc

Create several ad groups within campaign, 10-30 keywords per ad group, 2-3 ads per ad
group

Quality Score Factors

Expected Click-through-rate,

Landing page experience (relevancy, easy to navigate, transparent to business and customer
data)

Relevance of the advertisement to the search query
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Use of Google advertising extensions and their leverage

How to get higher Quality Score– Improve ad quality with right keywords and ad copy,
landing page experience and leveraging ad formats

Deﬁne your Goals

Increase traﬃc, generate phone calls, drive in store visitors, educate customers

Goal- Objective, motivation, eﬀort and KPI

Goal Example- Online sales -> I want to buy -> Sell ﬁlters -> 100 ﬁlters sold by October

Have speciﬁc campaigns for certain customers’ needs and their motivation

Set up 1 campaign for each goal

Deﬁne your Customer and the Product they want

Put yourself in your customer’s shoes

What are they motivated by?

Where do they spend most of their time?

Why are they interested in your product?
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What will convince them to buy?

Mark -> 42 -> graduate -> orthodontist -> 10 years -> needs for work -> iPhone/desktop ->
online 4 hours per day -> young professional who enjoys tech, entrepreneurial, skeptical,
motivated by recommendations for other colleagues
Make sure your ad text helps solve your customer’s problem with your product

Successful Google AdsWords Campaigns

Persistence -> spend money -> review data -> reﬁne campaign -> repeat

*Common to lose money in the ﬁrst month, make educated guesses and be savvy with data.
Be patient with Google Ads and let data sink in to close the gap.

Exploring the Interface

Sidebar- Campaigns -> Ad Groups within that campaign

*Graph icon shows graph data over time

Home

Campaign- Campaigns, Ad Groups, Settings, Ads, Keywords, Audiences, Ad Extensions,
Dimensions

Opportunities
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Tools

Researching Keywords

People don’t search for pre-owned vehicles; people search for used cars

Speak the language of your customer

The best advertising is speciﬁc

For each ad group, develop an ad theme and a list of keywords

Think like a customer, organize by theme,

(men’s boots -> men’s rain boots, men’s work boots) be speciﬁc,

5 to 20 keywords per ad group

Google Keyword Planner

Search volume, relevance, competition

What is your customer thinking?

What are they looking for?

How would they search for it?
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Identify your unique selling proposition

‘search for new keywords..’ -> add in your keyword terms -> ‘get ideas’

look into diﬀerent ad groups for ideas, add keyword ﬁlters on sidebar, ‘add to plan’ so you
can make an ad group from all the keywords you select, type in your landing page and see
what Google suggests

‘get click and cost performance forecast’ -> type in keywords -> ‘enter a bid’ -> see daily
forecast

Five keyword options

broad match- default, matches words that are closely related such as synonyms, captures
large audience, irrelevant clicks

broad match modiﬁer- use + in front of keyword (+womens +hats) contains close
modiﬁcations but not synonyms, can be in any order, can have irrelevant clicks

phrase match- use quotes around phrase (“womens hats”), must be in speciﬁed order

exact match- use brackets ([womens hats]), search cannot contain any other term

negative match- use – (-women) prevents ad from displaying when search contains that term

Creating your ﬁrst Campaign
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+ Campaign -> ‘Search Network Only’ -> click ‘all features’ (dynamic search ads?) -> Name
campaign with..

Goal | Objective |Targets | Eﬀort

Ex. Search | Online Reservations | USA SF Intent | Summer Discount

-> Uncheck ‘include search partners’ -> Choose speciﬁc locations -> leave locations as
recommended -> Unless you have a good reason only target one language ->

Bid Settings

“how much is a sale and what is the max I’m willing to spend each day for your goal”

100 for book now and 50 for max per day, Cost per acquisition is 50..
“how many clicks will it take for someone to purchase a sale?”

3% CTR will click on ad with 1000 impressions which is 30 people (people who click on ad is
CTR, 3% is good) -> 5% will click on ‘Book Now’ on the site which is 30 people X 5% which is
1

-> In this example you need 30 clicks for 50 dollars or less. Divide 50 CPA (which you
determined is the price for a sale) by the clicks needed to get a sale which is 30, so $50/30 =
$1.66, which is how much your max pay should be, ‘Default Pay is 1.66’

Set budget based on how much you can aﬀord and how many conversions you can hope for
each day. Start out with a sample budget you feel comfortable spending within the ﬁrst
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couple months

Ad Extensions

Location- help people nearby ﬁnd your nearest storefront or give you a call

Site links-add links to help people ﬁnd what they are looking for, promotes certain section,

*Use a strong CTA to help people to understand what they are getting, use 6-8 sitelinks

Call- allows someone to click within ad and allow them to call you

App- show a link below add that sends to the appropriate ad store

Review- showcase positive 3rd party reviews from reputable sources

Callout- add descriptive text to your ad to show what you have to oﬀer

Enable as many extensions as you possibly can!

Advanced Settings

Schedule- For when you want ad to show during certain times

Ad delivery/ad rotation- leave for ‘optimize for more clicks’ and then ‘optimize for
conversions’ down the line
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Ad Group

Headline- grab attention of user

Web address/display URL

Description line 1-

Description line 2-

Tips for Ads: Highlight what makes you unique

What makes you stand out?

What is your unique selling point?

What key features does your product/service oﬀer?

What is the motivating factor for your persona?

Use a call to action for what you want people to do

Make sure your landing page is relevant and allows them to immediately take action

Use sales terms in your ad copy! Give them info on how they can make a decision!

Match your ads to your keywords to demonstrate ad relevance, and your landing page!
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Create 3-4 ads for each ad group and provide diﬀerent copy for each

Create a separate ad group for each theme or product that you oﬀer

Add keywords one per line, start with 10 keywords! Keep an add group to a tight theme

‘Below ﬁrst page bid’ means the max CPC is too low

‘Low search volume’ means it’s not worth bidding on

Create only 3 or 4 ads at a time!

Campaign -> Keywords -> Automate -> Create Rule for Ads -> Send email when.. ->
Requirements -> Send Email for ads when CTR < 1%

Modify columns once you begin to track your conversions

Monitoring your advertisements

Monitor what works and what doesn’t over time

‘Segment’ your data to analyze

Campaigns -> Dimensions -> Filter -> View: Hour of Day to see how well ads perform during
hour of day or View: Geographic to see where ads are best clicked

Diﬀerent Reports
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Search Term- what led people to click on your ad

(Campaigns -> Dimensions -> View: Search Terms)

Auction Insight- Shows if competitors ads are showing more than yours

(Campaigns -> Details -> Auctions Insight ALL)

User Location- shows where users are clicking and seeing your ad

(Campaigns -> Dimensions -> View: User Location)

Understanding ROI

The ratio of your net proﬁt to your costs

Revenue-COGS / COGS

Measure conversions and evaluate your ROI

Setting up Google Analytics

Tools -> Google Analytics -> Admin -> Google Ads Linking -> New Link Group -> Select check
box and continue -> Link Accounts

Conversion Tracking
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What is our conversion?

Where does the conversion happen?

Tools-> Conversions -> Add conversions-> Website -> Fill out info appropriately

Count- all for sales/ unique for leads, Conversion window- how long after an ad click you want
to track conversion, 15 day, Leave Optimization ‘on’

Google Ads Campaign Experiment

Can run one experiment at a time

Campaign -> Settings -> Advanced Settings -> Experiment -> Change..

Optimization Areas

Improve ROI- relevant landing page and keywords, increase bids on proﬁtable keywords,
Display network down the line

Keywords- use negative keywords, remove duplicate keywords, optimize low performing
keywords

Ad text- use keywords in ad text, include a CTA, pre-qualify traﬃc such as pricing or
discounts, use ad extensions

Bids- experiment with various bids, allocate budget based on performance, bid adjustments
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Quality Score

Campaign -> Keywords -> Status -> Remove low quality keywords from ad groups -> Modify
columns to show Quality Score, you want a Quality Score of 7 or higher

Bid Adjustments

Provide full control of when, where and on what you want to show your ads on

Campaign -> Settings -> Locations | Ad Schedule | Devices for diﬀerent adjustments -> Bid
adj. ‘increase by’ decrease by’

Remarketing

When people have already visited your site and you want to target them again

Campaigns -> Shared Library -> Remarket to people who visited your site before -> Choose
dynamic remarketing if makes sense -> Add tag to site -> Return to audiences -> Tag details
-> View tag implementation instructions -> View Google Ads Tag for Websites and add to
every web page

‘Set up remarketing list’ for speciﬁc retargeting

Audience Insights for remarketing lists

Campaigns -> Audiences -> Shared Library -> Select remarketing list that you want to see
the audience for -> Examine insights
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Add Ad Extensions

Campaign-> Ad Extensions-> View: __ -> ‘+ Extensions’ to add new extension

Customize a landing page for each keyword

Campaign-> Keywords -> Edit -> change Final URL’s
Google Ads Tips and Tricks
Optimal results come from targeting the right people, at right time, with the best message.

What are you willing to pay for a lead or new sale in your business?

Keyword planner- Adjust location, get top ten searches

CPA of a new lead or sale

Tools -> Conversions -> Fill Out -> Add Code to Website

Understand your spend in Google Ads is working for your business

Tips

Delete or pause the poor performance

Look at exact match keywords, broad means you are ﬁshing in larger see
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Google Auction Insights (who you are bidding against)

Impression share, average position, overlap rate, position above rate, top of page rate, and
outranking share

Campaign -> Details -> Auction Insights -> Can ‘Segment as well’

Google Bid Simulator (what happens if you spend more money)

Campaign -> little graph next to Budget

Bid Adjustments

Device, location and time of day

Campaigns -> Settings -> Edit all features if don’t see bid adjustments

“Are your ads as customised as they can be?”

“Pop by and use code 123 for a 10 discount today only”

Types of Keywords

Explicit- computer memory

Problems- how to speed up computer
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Symptoms- Blocked drain

Product names- MacBook Pro

A/B Testing on website pages

You can send traﬃc to a page, but if it doesn’t convert then you are wasting money

Have one main outcome per page

What is your most wanted response? MWR

Make it easy for the person to achieve their most wanted response

Test- colors, CTA, style of forms, more/less images, headlines

5% increase is good. Aim for 100-300 per page to test, Use same ads, Always be testing

Track and measure everything to know what is working and what needs adjustment

Remarketing- connect with people who have visited your site

Admin -> Audience deﬁnitions -> Audience -> New Audience -> Next Step -> Buy on your
website -> Choose category Remarketing Lists -> New User

Tips- Track Conversions! Use clear message and bright colors, view through conversions
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Google Audience Insights

Customer Match gives you a way to ﬁnd out more about your own remarketing, and ideal
when you have a built email list.

Shared library -> Audiences

Aﬃnity Audience- Select from these audiences to reach potential new customers and make
them aware of your business.

Custom Aﬃnity Audiences- advertisers can create audiences that are more tailored to their
brands

In Market Audiences- Select from these audiences to ﬁnd consumers who are researching
products and actively considering buying a service or product like those that you oﬀer

Remarketing lists for search ads

Begin to bid on keywords that you usually wouldn’t bid on. The ads are only shown to people
who’ve visited your website

Treat someone who has visited already as special

Shared Library > Audiences -> Choose option and ﬁll out rules

Run tests and adjust your course of action based on your results
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Who would you most like to re engage?

Audit to see whats working

Use sitelink extensions, use call extensions, add location extensions, use product listing ads
when you are e commerce, don’t worry about negative keywords impacting quality score, use
exclamation points, use numbers of ads, look at performing ad, landing page quality- relevant
transparent and navigability, revisit your campaigns

Setup Target CPA Bidding

Google can raise bids on ads that seem to generate more conversions

Campaign -> Settings -> Edit Bid Strategy -> Target CPA, Think how much would you pay for
a lead?

Know your outcomes and then optimize your account accordingly

Campaign -> Settings -> Ad Delivery -> Optimize for conversions

Dynamic Ads- ads appear based on the content of your website

Displays ads when it thinks searches are relevant

Campaign -> Search Only -> Dynamic Search Ads

Connect Google My Business Account
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Use location extensions to connect your physical location

Campaign -> Ad Extensions -> View -> Location Extensions ->Click Extension

Add Sitelinks to your Ad

Campaign -> Ad Extensions -> Sitelinks -> Extension -> New Sitelink

Phone as a CTA

Campaigns ->Ad Extensions -> Call Extensions

Campaigns -> Call-Only -> Advanced Scheduling, ensure you will pick up the phone if called

Advanced Local Targeting

Settings -> Locations

You can increase or decrease with bid adjustment

Campaign -> All features edit -> Advanced under locations, target

Promote your app

Campaign -> Universal App Campaign -> Fill Out

Opportunities Tab
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Opportunities -> View opportunities

Google Ads Editor

Download -> All Campaigns

Reports Tab

Campaign -> Segment to segment

Reports Tab to show reports

Campaign -> Dimensions to also segment data

Google Ads Tools

Optmyzer.com
clickmeasure.com
supermetrics.com
semrush.com
wordstream.com

Google Ads Scripts

OpenWeatherMap API to adjust bids on weather

Dynamic keyword insertion- adjust ads by inserting speciﬁc keywords
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Pause keywords with low quality score
What are Google Ads Remarketing Campaigns
Used to re engage visitors who have visited your site and have left, and is useful for CRO.

We get a tracking code from Google and we use rules to specify the visitors we want to
advertise. You target them by utilizing diﬀerent ad copy and coupons.

Setting up Remarketing in Google Ads- limited functions, suitable for limited business case.

Setting up Remarketing in Analytics- essential for successful campaigns

Audience Builder in Google Analytics- specify customer demographics, or technological
requirements or behaviors or users visiting within speciﬁc dates etc.

Types of Remarketing

Standard- target passed visitors, is not contextual.

Dynamic- target past visitors but can show them dynamic ads speciﬁcally towards the
products they they viewed

Remarketing for mobile apps- show ads to people who have used the mobile app or website,
and will send when on other competitor apps

Remarketing lists for search ads- build lists of past visitors and we target visitors when they
do follow up searches
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Video remarketing- retarget to visitors when they have viewed a video or on youtube, shown
on youtube

Aim to increase ROI: increase conversions and reduce CPA

Linking Google Ads with Analytics- sign into google analytics -> admin tab -> property ->
product linking: Google Ads linking

How to add Google Ads Remarketing tag (if you haven’t used a Google Analytics tag)- sign
into Google Ads -> top right drop down -> shared library -> audience manager -> audience
sources -> Google Ads tag dropdown -> edit source -> ﬁll in info to set up tag -> save and
continue -> copy tag and add to website or access through tag manager -> Use Tag assistant
chrome extension that will verify code snippets -> tag needs to go before the body tag!

Basic Campaign Setup

Sign into Google Ads -> all campaigns -> create new campaign -> select display network ->
select goals and continue -> add campaign name, locations, languages, bidding..remove
enhanced cpc, assign daily budget -> additional settings, content exclusions, -> ad group
name -> audiences: remarketing -> name ad group and create your ads

Remarketing lists and rules

Sign into Google Ads -> dropdown menu: shared library -> audience manager -> audience
lists -> add new list: website visitors -> audience name, list members, visited page for
speciﬁc URL’s and other rules to segment
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(Minimum list size is 1000 visitors for Google Ads)

Advanced Remarketing campaign setup in Google Analytics- log into google analytics ->
admin tab -> property -> audience deﬁnition -> audience -> new audience ->link google ads
and analytics account -> deﬁne audience: create new -> adjust demographics, technology,
behavior, date of ﬁrst session, traﬃc etc. and save -> go into Google ads and select
campaign -> display network tab -> interests and remarketing -> connect list with Google
Ads campaign

Switching between Analytics and Ads for advanced targeting options- choose google ad
campaign -> ‘keywords’ and ‘placements’ tabs on left, ‘audience’ tab to add remarketing list

Setting up dynamic remarketing for ecommerce

A way of further reﬁning your targeting. Ensure Google Ads and Analytics is linked. Update
tags, custom dimensions, create lists, create attributes for speciﬁc products

Updating tags and specifying custom dimensions- sign into google analytics -> admin tab ->
property -> custom deﬁnitions -> custom dimensions -> custom dimensions -> create
custom dimensions -> ﬁll out information

Creating audiences for dynamic remarketing- (‘cart abandoners’ or ‘high value customers’
are example of a remarketing audience)

Attributes for dynamic remarketing- sign into analytics -> admin tab -> property -> audience
deﬁnitions -> dynamic attributes -> add a new attribute -> conﬁgure and assign values to
each attributes chosen, then you create create a dynamic display ad in Google Ads
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Creating a dynamic remarketing campaign- campaigns -> add a new campaign -> display
network -> ﬁll out goals -> campaign name, locations, daily budget, additional settings:
dynamic ads, data feed: select a feed or new feed you need to create. Ad group name,
audiences -> select remarketing, under website visitors select your remarketing lists -> ad
group bid, create your ads: new ad, responsive ad.

Setting up a dynamic remarketing feed for display advertising- feeds are like spreadsheet
ﬁles that contain product info that acts like a database for Google to access.

Creating and uploading a feed- Google Ads ->business data -> data feeds -> dynamic display
ad feed -> choose ﬁle and upload spreadsheet -> check back in a few hours to see if there
are any errors. Ensure accuracy.

Setting up your RSLA campaign- remarketing lists for search ads is a way to target any range
of keywords that users search for. Used for when visitors come to your website and then
leave to compare prices. RSLA allows you to set up a list of visitors from your site,

Campaigns -> new campaign -> search network -> set up campaign! -> audiences -> add
audiences -> select ad group -> add button, select remarketing to select one of your lists ->
save info and then you can run ads exclusively to people who have visited your site and are
searching for for competitor pricing.

Deciding on a remarketing budget

Up to 5% as a test budget, target various ad sizes to obtain discounted inventory.

What to ask to determine CPC Variable
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Do we want to spend less or more on visitors who already visited our website?

Do we want to adjust our bid to be higher for people who visited our shopping cart?

Can we adjust our bid to be lower for devices that produced a higher bounce rate or even
avoid remarketing to those devices?

What to ask to determine daily budget variable

How many new leads can our physical resources handle right now?

During initial tests, did we see a higher conversion rate from our remarketing eﬀorts?

Would we prefer to focus on a new website visitors via old marketing eﬀorts, or do we prefer
reengaging old visitors? And what balance shall we strike? For example, we may choose to
spend 90% of our budget on attracting new visitors and just 10% on remarketing.

Can you think of any speciﬁc visitors to your company’s website for retargeting? What would
be the best targeting criteria to apply?

Advanced targeting combinations

Selected keywords- ad gets triggered only when reading relevant content on web

Selected placements- hand picked magazines considered to be high quality where ads can be
displayed.
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Selected audiences- remarketing lists that you have

Demographics- used with google analytics more

Locations- works well when setup in Google Ads

What is there that you can do, what combination of targeting criteria will produce better
conversions?

Campaign monitoring

Use google analytics, have frequent campaign monitoring, regular adjustments

Seeding your initial remarketing lists

Refers to how and where we obtain the initial visitors we want to add to our remarketing lists.
Try to have at least 5000 targeted people on a list.

Funnel-based segmentation vs. proﬁle-based targeting

Each remarketing list is based oﬀ a certain behavior. You need high traﬃc levels, with at
least 1000 users. Funnel based segmentation is best for mass marketing such as publishers
or ecommerce. Proﬁle based targeting is used for niche businesses with high-value clients

Diﬀerences between B2B and B2C remarketing

B2B- higher LTV’s, justify higher CPC’s and acquisition cost, precise targeting remains crucial,
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ﬁnd and target the right user and ﬁnd out who the decision makers are

B2C- lower LTV’s, balance lower CPC’s with less accurate targeting

Seeding an Google Ads remarketing list with a LinkedIn campaign

Google Analytics: set list rules for landing pages -> LinkedIn: Create a targeted campaign ->
Google Ads: Create a remarketing campaign

B2B Campaign Design

Audience: high quality online business magazines

Google Display Planner: indicates suitable volume of quality inventory, but how do we
exclude certain readers

LinkedIn Marketing Services: indicates a good volume of C-Level proﬁles, but how much time
do busy people spend on LinkedIn

Solution- LinkedIn: seed a high quality remarketing list -> Google Ads: remarket to the
audience on the list for the next six months.

Client proﬁles of decision makers. Role of DM, company size, location, industry, information
of proﬁles you would like to exclude.

Campaign Setup- Landing Page: Clear CTA and URL for ad creation -> Ads: Create a list (ex.
‘LinkedIn B2B list’) -> Google Analytics: In audience deﬁnitions, specify LinkedIn as the traﬃc
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source for your list. -> LinkedIn campaigns: Create an ad group for both Display Ads and
Sponsored InMail, they will work together to drive visitors to your landing page.
Advanced Google Ads Techniques
Auction Insights and bid simulator

Typical tools used when planning new campaigns and optimizing existing campaigns.
Produce list of existing google ads campaigns Campaigns -> budget column, small graph
next to budget -> select campaign you want -> campaign bid simulator. Produce auction
insight report- campaigns -> select campaign -> more -> select auction insights to see
benchmark performance against competitors and can be segmented. Look at top right corner
to segment by time or device -> download report as pdf.

Google Display Planner

Old Ads Interface -> Tools -> Display Planner -> enter keywords -> set targeting -> get ad
group ideas or placement ideas (shows domains that have content for your particular
keyword) -> select all placements or select cookies per week column to see volume of
speciﬁc sites and highest traﬃc. You can add websites to a list to get a forecast of data based
oﬀ the sites that you have selected.

To see most popular sites according to visitor volume- display planner -> ﬁnd the top
placements by location -> select topic(s) -> get placement ideas.

New Ads Interface -> Campaigns -> select campaign -> ‘overview’ in left sidebar -> ‘selected
.. ‘ will show you details about selected options for campaigns
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Ads Editor

Download Ads Editor -> sign in and receive authorization code -> paste code to then
download campaigns from the associated google account -> select an ads account

Google Ads Manager Accounts

Used when you want to manage multiple accounts from a single dashboard. Makes reporting
easier and consolidated billings. Setup manager account -> use a diﬀerent new email
address account and then link it. New Google Ads Interface -> Select new manager
associated email -> select google ads account you want to work with. Shared library in left
column in new Google Ads is set across multiple accounts within a manager account, not
across a single account and all the campaigns within that account. Top right -> setup ->
account access to see accounts available and access provisions to individual people.

Reporting tips with Google Ads

New Google Ads interface -> campaigns -> select campaign and inside ad groups -> right
side, button with 3 columns to modify columns to select metrics for report -> then click 3
dotted button to download report or set up automated rule on when you want a report sent to
people.

Set up reports on a grand scale -> Top right area -> reporting column -> select reports or
predeﬁned reports or dashboards -> select blue + to create a new report -> drag and drop
elements you want to show -> click on top right clock to schedule the report to be sent out
and to who
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What are Google Ads Mobile Marketing Techniques

Mobile landing pages- google chrome -> go to a speciﬁc web page -> top right corner select
3 button column -> more tools -> developer tools -> select speciﬁc mobile phone to see the
view that you can expect to ﬁnd. Use this to see user experience and to get a feel of a range
of devices that the user will see.

Bid adjustments for mobile and tablet- select campaign -> ad group level -> devices left
column -> hover over bid adi area and edit for a speciﬁc device such as ‘Tablets’. Select
columns tab to modify columns for devices, you can use bid simulator columns as well.

Mobile search vs. display metrics- Google Chrome webpage -> top right 3 button -> more
tools -> developer tools -> open up two screens: google search and a speciﬁc website.
Display usually has a lower conversion rate than mobile search ads. You need one of the top
2 search ad placements to get more visibility. Expect lower conversions for mobile display.

Handling excessive mobile bounce rates- high bounce rates are stressful but there is a
process on how to deal with them. Start by assessing page load time, use a report to
segment by device times -> if times are normal, then compare a speciﬁc landing pages
across diﬀerent device types. There are three causes of high bounce rate on mobile devices:
user experience problems, copywriting issues or content quality or server response time and
lastly there could be an inventory problem with Google AdSense, which is out of your control.

App installs for mobile marketing- all campaigns -> blue + button to create new campaign ->
universal app -> specify operating system of app -> enter app name etc. -> only pay for an
app install! It is the best and most cost eﬃcient way
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Proximity marketing: location targeting- Google Ads -> select campaign -> ad groups ->
locations -> blue pencil button to add multiple locations

Using Automation in Google Ads

New Google Ads interface -> Top right vertical 3 button -> bulk actions -> rules -> blue +
sign to add new rules -> select to change either campaign, ad group, keyword or ad rules.
You can use this to set up bid adjustment rules

Keyword performance rules- New Google Ads interface -> Top right vertical 3 button -> bulk
actions -> rules -> blue + sign to add new rules -> keyword -> change keyword bids ->
apply to all enabled keywords, action:decrease bids -> bids decrease by percentage:10% ->
condition: conversion rate < 5%

Multi location bid adjustments- new Google Ads -> campaigns -> locations -> bid adj. pencil
sign

Google Ads Scripts

Scripts can help you automate procedures with external data/API’s. New Google Ads -> 3
vertical button -> bulk actions: scripts

Automate a weather based campaign- register API key at openweathermap.org -> copy
template spreadsheet: google developer tools -> create or adapt script based on the Google
sample script -> schedule and run the script

Dynamic search and display automation- can be used for behavior or feed based to show

mind movement machine.

google ads. | 32

dynamic search or display automation

Google Ads Ad Customizers- used to receive higher CTR with more relevant ads, it is less
work as it reduces the need for multiple campaigns, it uses automation via feed and it is
programmatic

Dynamic keyword insertion can be used with uploading a spreadsheet. When Google Ads is
pulling spreadsheet data, it can be updated in real time and prices could change dynamically

Google Ads Customer match- used to reach customers that are already in your database
(that have a gmail account). New Google Ads -> shared library: audience manager -> blue
plus sign -> customer list -> specify membership duration and then ‘upload and create list’
-> add new campaign -> display network only -> ﬁll out campaign info -> interests &
remarketing -> customer email lists

MCC Scripts- used to manage multiple Google Ads accounts through one single script

Video Advertising

Google Ads -> campaign -> add new campaign -> video and ﬁll out information, ensure you
select appropriate audiences if necessary.

Advanced Google Ads Tips

Landing pages convert, not keywords. Default settings can be costly, scale up smartly and
not aggressively
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Click to share on Facebook (Opens in new window)
Click to share on Twitter (Opens in new window)
Click to share on LinkedIn (Opens in new window)
Click to share on Reddit (Opens in new window)
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